PDFE ActiveX DLL
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Before using PDF ActiveX DLL you must install Adobe’s PostScript Printer Driver and
GhostScript. Both of these programs are free, easy to install, and can be downloaded from
the internet. One of the best reasons for using PDF ActiveX DLL is that you can develop
applications to produce PDF files which don’t require Adobe Acrobat or any other third
party software which must be purchased. Also, you can install your application on as many
machines as you like without paying expensive royalty fees! PDF ActiveX DLL is a great,
low-cost software development solution for large companies that need PDF publishing
capabilities.

1) First off you will need aprint driver to create PostScript files. Y ou can download Adobe’ s free
PostScript Print Driver from http://www.download.com or http://www.adobe.com

To download this print driver from Download.com go to:

http://www.downl oad.com/A dobe-Universal -Post Script-Printer-Driver/3000-2116 4-10184850.html ?tag=Ist-0-1

To download from Adobe’ s web site go to:

http://www.adobe.com/support/downl oads/main.html
(look for PostScript printer drivers)

Alternatively, you can download the Window’ s version by clicking on this link
http://www.getfilez.com/winsteng.exe

To install the PostScript Print Driver:

a) Runtheinstallation file winsteng.exe
b) The following screen will appear. Click the Next Button.

“Welzome to the Adobe® PostScript® Printer Driver
zetup program. Thiz program will ingtall a PostScnpt
- Frinter on your comprter.

[t iz strongly recommended that you exit all \Windows programs
befare running thiz Setup program.

Click Cancel to guit Setup and then cloze any programs pou
have minking. Click Mest to continug with the Setup progran.

WARMIMG: Thig program iz protected by copyright law and
international treaties.

IInauthaorized reproduction or digtribution of this pragram, or any
portion of it, may result in zevere civil and criminal penalties, and
will be prozecuted to the maximum extent pozsible under |aw.

Cancel |



http://www.download.com/
http://www.adobe.com/
http://www.download.com/Adobe-Universal-PostScript-Printer-Driver/3000-2116_4-10184850.html?tag=lst-0-1
http://www.adobe.com/support/downloads/main.html
http://www.getfilez.com/winsteng.exe

c) Click the Accept Button

End User License Agreement 5[

Pleaze read the following license agreement. Use the scroll bar to wiew the rest of
this agreement,

ADOBE SYSTEMS INCORPORATED -
ELECTROMIC EMD USER LICEMSE AGREEMEMNT

MOTICE TO USER:
THIS IS A COMTRACT. BY INDICATING YOUR ACCEPTAMCE BELOY, Y'OU

SCCEPT ALL THE TERMS AMND COMDITIONS OF THIS AGREEMENT IMCLUDING IM
FARTICULAR THE LIMITATIONS OM: USE COMTAINED IM SECTIOMNS 2 AND 4: AND
WARAANTY AND LIABILITY IW SECTION 5. ¥'0OU AGREE THAT THIS AGREEMENT
IS EMFORCEAELE LIKE &MY WHRITTEM MEGOTIATED AGREEMEMNT SIGHED BY

0L

Thiz End zer License Agreement accompanies the PogtScript® driver software product,
ather software and related explanatary maternials collectively the ('S oftware']. LI

TO ACCEPT THIS AGREEMEMNT, PRESS “"ACCEPT." IFv0OU DO NOT AGREE WITH THE
TERMS AWD COMDITIONS OF THIS AGREEMENT. PRESS "DECLINE™ AND QUIT. YOLU

WILL MOT BE ABLE TO USE THE SOFTARE. —

< Back W DECLINE |

d) Click the Next Button

Printer Connection Type ﬂ

How iz pour printer connected to your computer?

% |tz directly connected to your computer [Local Printer]

™ |t iz connected to your network [Metwork Printer]

Cancel |




e) Select FILE: and click the Next Button

Local Port Selection x|

Click the port pou want to uze with this prinker.
Click. Configure Part to view or change that port's parameters.

Ayailable ports:

WWASI_TREEMSHP4000.OPERATIONS ASI Laocal Port «
BIFORT Local Port —
COMIT:  Local Part

COMZ: Local Port

Local Port
Local Port

Laocal Part ‘
'l

i |

LConfigure Part... |

< Back ‘w Cancel |

f) Click the Next Button

Select Printer Model x|

Select the model of wour printer. If pou do not find your printer listed, you can click
Brawse ta loak far printers at ather locations or consult paur printer dacumentation
far a compatible printer.

If your zannot find a zuitable printer listed, zelect Adobe Generic PostScript Printer.

Printers:

Generic PostScript Prinker

DEFPRTRZPPD 13492 bytes 04,2302 Browse. .. |

< Back

Cancel

d




g) Click the Next Button

Will thiz printer be shared with other network, uzers?

" Shared &' Not shared

IF pou chooze Shared, give thiz printer a share name.

Share Hame; |

Select the operating system of all computers that will be printing to
this printer.

Windows 35 and 'Windowes 33
Weindows MT 4.0 <26

h) Select No and click the Next Button

Cancel |
X

Printer Information

'ou can use the following name or enter anather name for this
prinker.

Printer Mame: |5 eneric PostS cript Printer

Do yow want to uze this printer az pour defaulk printer?

i Yes

okl

YWwhould you like to print the test page?
" Yes [Recommended)

< Back et » Cancel




i) Click theInstall Button

Setup Information x|

Setup haz enough information to start copying files. | pou want
to review or change any settings, click Back. |f you are zatizfied
with the settingz, click Install ta beagin copying files.

Current Settings:

Diriver [nformation: :I
Werzion: PScrpth 5.2
Destination Directany: C:YWaAMDOWS Seystem3@haponlhs

Frinter Informatiorn:
Generc PostScrpt Pri [Copw 1] on FILE:
The PostScript Printer Description [PPD] file iz DEFPR1
Thiz prinker will not be the default printer.
& tezst page will not be printed.

j) Select No and click the Next Button

o
Cancel |
x|

Printer Configuration

[F wou purchazed ophions far paur prinker, zuch ag additional fravs
ar memaony, it iz recommended that pou configure these now.

To do this, zelect “'es below and click Mest to open Printer
Propertiez. Click the Device Optiohz tab and zpecify yaur printer
configuration. %hen done, click OF to cloge Printer Properties.

YWiould you like bo configure your prinker nom'?

........

< Back Mewt > Cancel




k) Click the Finish Button

Setup Complete x|

Setup has finizhed copying files to your computer.

The inztallation containg the file ReadMe that provides additional
infarmation about the products vou have installed.

¥ Yes, | want to view the Feadhe file.

2) After installing the printer driver you will need to modify settings for the PostScript Print Driver. To
do so click Window’ s Start Button, select Printers and Faxes from the menu, right-click on
Generic PostScript Printer and select Properties from the popup menu, then click the Ports Tab.
Select the Print to File option if it is not already selected.

!sf Generic PostScript Printer Properties ﬂﬂ
Color Management I Se Device Settingz I
General I Sharing Advanced

g Generic PogtScript Printer

Frint to the following port(z]. Documents will print to the first free
checked port.

Port | Dezcription | Frinter |:|
U COM2: Serial Port
0 COM3_SerialPor

L1 COM4: Serial Port J ‘

Ll POF-.. POF-+<Change monitor - PDF Complete
O BIP.. Local Part Black lce Printer Driver ;I

Add Part.... | Delete Port | LConfigure Part... |

™| Enable bidirectional suppart
[ Enable printer poaling

] I Cancel Spply




3) If you want your PDF filesto appear in color you will need to make another change. To do so click
the General Tab and click the Printing Prefer ences Button.

&7 Generic PostScript Printer Properties 7| x|

Color Manadg
General

Location: I

et I Security I Device Settings
Sharing I Puorts I Advanced

cript Printer

Caormrment;

tadel: AdobePS G enencPostS criptPrinter

— Features
Color: Mo Paper available:

Double-zided: Mo Letter ﬂ

Staple: Mo
Speed: 8 ppm
b awirmum rezolution: 300 dpi ﬂ

Frinting Preferences...l IF'rintIest Fage |
|

k. I Cancel | Smply |

4) Click the Advanced... Button

&_ Generic PostScript Printer Printing Preferences ﬂﬂ

Layout | Paper/Quaity |

Orientation

- Landscape
{” Rotated Landscape

Pages Per Sheet: I 1 vI

I Advanced... |
(] I Eancel Smpli




5) Change PostScript Output Option to Optimize for Portability. If thisoption is set to Optimize for
Speed then your PDF documents will appear in black and white. Click the OK Buttons to save your

changes.

AdobePSGenericPostScriptPrinter Advanced

2%

EIQQ Paper ioutpuk

............. Paper Size: Letker

............. Copy Counk: 1 Cope

=I-- ] Graphic

............. Scaling: 100 %

------------- TrueType Font: Download 5 Softfont

ﬁs AdobePSGenericPoskScriptPrinter Advanced Document Settings

Document Spkions
E---ﬁa PostScript Options

PostScript Cukput Option:

------------- PostScript Language Level: 2
------------- Send PostScripk Error Handler: Yes
------------- Mirrared Oukpuk: fo

------------- Megative Cutput: MNo

| Cptimize For Parkability:

i

x|

Cancel |

6) Congratulations! Y ou finished installing the PostScript Print Driver necessary to create PostScript
files! Now you will need to install the free program, GhostScript, which converts PostScript files to

Portable Document Format files (PDF).

To download GhostScript from the University of Wisconsin Madison’s web site go to:

http://www.cs.wisc.edu/~ghost/doc/AFPL/index.htm

We recommend that you install GhostScript version 8.54 which is the most recent version at the time of this
writing. Y ou can download the 32-bit Window’ s version of GhostScript 8.54 by clicking on this link
http://www.getfilez.com/gs854w32.exe To download the 64-bit Window’ s version click here

http://www.qgetfilez.com/gs854w64.exe

To install GhostScript:

a) Runinstallation file gs854w32.exe or gs854w64.exe
b) The following screen will appear. Click the Setup Button.

WinZip Self-Extractor - gs854w32.exe

~& Thiz inztallz: AFPL Ghoztzcnpt 8.54.
AFPL Ghostzcnpt dizplaps, prints and converts PostScn®

and PDF files.

Cancel |
About |



http://www.cs.wisc.edu/%7Eghost/doc/AFPL/index.htm
http://www.getfilez.com/gs854w32.exe
http://www.getfilez.com/gs854w64.exe

c) Click the Install Button and wait for the installation to complete.

AFPL Ghostscript Setup X|

Thiz inztalls

g AFPL Ghostzcnpt 8.54
= Copynght [C] 1994-2008 artofcode LLC, Benicia, California, 15,4, All
rights rezerved.

Requires 25 Mbytes dizk zpace.

[nztall bo directory

IE:"uF'ru:ugram Filezhgs Browse...

B&dd shortcuts o [T Al Users

IGhDstscript Browse...

W Inztall Ghostscript Fonts

[ Use windows TrueT ype fonts for Chinese, Japanesze and Korean

Cancel | Help |

Using PDF ActiveX DLL with Visual Basic 6.0

1) Load Visua Basic 6.0 and create a new Standard EXE

2) From the Project Menu select References...

3) Select PDFActiveX and click the OK Button

4) Inthe General Declarations section of your form type the following code:
Dim oPDFActiveX As PDFActiveX.CreatePDF

5) Inthe Form_L oad subroutine type:

Set oPDFActiveX = New PDFActiveX.CreatePDF
oPDFActiveX.TempFilePath = “ C:\Temp”

PDF ActiveX can also be used in your .NET projects, VBA for Excel, VBA for Word, VBA for Access,
VBA for PowerPoint, and any other language which is compatible with ActiveX technology.

To add the PDF ActiveX DLL referenceto your VBA for Excel project:
1) Press ALT+F11 from Excel’s main screen to call the Visual Basic Editor.
2) From the Tools Menu select “References...”
3) Select reference "PDFActiveX" and click the OK Button.

To add the PDF ActiveX DLL referenceto your VBA for Word project:
1) Press ALT+F11 from Excel’s main screen to call the Visual Basic Editor.
2) From the Tools Menu select “References...”

3) Select reference "PDFActiveX" and click the OK Button.

To add the PDF ActiveX DLL referenceto your VBA for Access project:



1) PressALT+F11 from Excel’s main screen to call the Visual Basic Editor.
2) From the Tools Menu select “ References...”
3) Select reference "PDFActiveX” and click the OK Button.

To add the PDF ActiveX DLL referenceto your VBA for Power point project:

1) Press ALT+F11 from Excel’s main screen to call the Visual Basic Editor.
2) From the Tools Menu select “ References...”
3) Select reference "PDFActiveX” and click the OK Button.

Using PDF ActiveX DLL with .NET

1)
2)
3)
4)
5)
6)

7)

8)

Load .NET and create anew Window’s Application
From the Project Menu select Add Reference...

Click the COM tab

Select PDFActiveX in thelist and click the Select Button
Click the OK Button

At the top of the form type:

Imports PDFActiveX
Enter the following code after statement I nherits System.Windows.Forms.Form:
Dim oPDFActiveX As PDFActiveX.CreatePDF
In the Form1_L oad subroutine enter code:

oPDFActiveX = New PDFActiveX.CreatePDF
oPDFActiveX. TempFilepath = “C:\Temp”

Distributing PDF ActiveX DLL with your application

PDF ActiveX DLL may be distributed with your application royalty free. When creating the installation program
for your application you should include file MSINET.OCX (Microsoft Internet Transfer Control) if you are using
the functions UploadFile() and/or DownloadFile(). The file MSINET.OCX can be found in your Window’s System
directory which is C:\WINDOWS\SY STEM 32 on most machines. Some functions which access the PostScript
print driver require file PDFOSEND.EXE in your setup program. Thisfile islocated in your Window’s System
Directory. Y ou should install thisfile on the client’s machine in the same directory as the PDF ActiveX DLL or in
their Window’ s System Directory. The file PDFOSEND.EXE is used by PDF ActiveX DLL to send messages to

the “Print to File” window which pops up when printing with the PostScript print driver.

Properties

PDFPassword — Get/set PDF password (String).

PDFPermissions — Get/set PDF permissions (Long Integer).

PDFVersion — Get/set PDF version (Integer).

TempFilePath — Get/set path where temporary files will be created (String).
GhostScriptVersion — Get GhostScript version number (String).



Functions
CreatePDFfromA ccessReport() - Method to create an Adobe Acrobat (PDF) file from an Access report.

Requirements: Access and file PDFOSEND.EXE

Arguments:

strPDFFile As String PDF fileto create

strDatabase As String Access database to use

strReportName As String Report to use

Optional strPrinter As String Print driver. Default: “ Generic PostScript Printer”
Optional strPassword As String Access database password

Optional strFilter As String Report filter

Optional strWhereCondition As String Report where condition

Optional strSaveWindowCaption As Boolean Window caption. Default: “print to file”
Example:

Dim strPDF As String
Dim strMDB As String
Dim strRPT As String
Dim strPrinter As String
On Error Resume Next

Screen.MousePointer = vbHourglass
strPDF = App.Path & "\Report.pdf"
strMDB = App.Path & "\Author.mdb"
strPrinter = "Generic Postscript Printer”

‘Note: You may need to modify thisfile path

'strMDB = "C:\Program Files\Microsoft Visual Studio\VB98\NWIND.MDB"
'If you are using a non-English version of Windows

'you can modify parameter strSaveWindowCaption

'Use code below to create a PDF from a single report
StrRPT = "authors"
oPDFActiveX.CreatePDFfromA ccessReport strPDF, strMDB, strRPT, strPrinter
Screen.MousePointer = vbDefault
If Err.Number Then
MsgBox Err.Number & " : " & Err.Description, vbExclamation, "Error Message”
MsgBox "Access must be installed on this machine.", vblnformation, "M essage”
Else
‘open PDFfile
ShellExecute O, vbNullString, strPDF, vbNullString, vbNull String, 1
End If

khkkkhkkkhhkkkhhkkhkhhkhkhhkhkhhhkhhhkhhhkhhhkhdhhkhhhkhdhhkhkhhkhkhhkhkhhhkhdhhkhdhhkhdhhkhdhhkhdhhkhdhhkhkhhkhdhhkhkhhkkddkxkrd,x*x*,%x
CreatePDFfromAutoCAD() - Method to create an Adobe Acrobat (PDF) file from AutoCAD DWG and DXF files.

Requirements: AutoCAD and file PDFOSEND.EXE



Arguments:

strPDFFile As String PDF fileto create

strDWGFile As String AutoCAD DWG/DXF fileto use

Optional varLayout As Variant Layout to use (can be a name or number greater than 0)
Optional strPrinter As String Print driver. Default: “ Generic PostScript Printer”

Optional strSaveWindowCaption As Boolean Window caption. Default: “print to file”
Example:

Dim strPDF As String

Dim strDWG As String
Dimi AsInteger

Dim strPassword As String
Dim strPrinter As String

On Error Resume Next

strPDF = App.Path & "\HelloWorld.pdf"
strDWG = App.Path & "\HellowWorld.dwg" ‘can also use DXF files
strPrinter = "Generic Postscript Printer”

oPDFActiveX.CreatePDFfromAutoCAD strPDF, strDWG, "layoutl”, strPrinter

If Err.Number Then
MsgBox Err.Number & " : " & Err.Description, vbExclamation, "Error Message"
MsgBox "AutoCAD must be installed on this machine.”, vbinformation, "M essage"
Else
‘open PDFfile
ShellExecute 0, vbNull String, strPDF, vbNullString, vbNull String, 1
End If

kkhkkhkkkhhkkkhhkkhhkhkkhhkhkkhhkkhhkkhkhkkhhhkhkhhkhkhhkhkkhhkhkkhhkhkhhkhkhhkhkhhkhkkhkhkhkkhkhkkhkhhkhkhhkhkhhkkhhkkhkkhkhkhkkhhkkhkkk kkkk*x*x*%
CreatePDFfromCrystal Report() - Method to create an Adobe Acrobat (PDF) file from a Crystal Report File.

Requirements: Crystal Reports and file PDFOSEND.EXE

Arguments:

strPDFFile As String PDF fileto create

strCrystal Report As String Crystal Report Fileto use

Optional strPrinter As String Print driver. Default: “ Generic PostScript Printer”

Optional strSaveWindowCaption As Boolean Window caption. Default: “print to file”
Example:

Dim strRPT As String

Dim strPDF As String

Dimi AsLong

Dim strPrinter As String

On Error Resume Next



StrRPT = App.Path & "\sample.rpt"
strPDF = App.Path & "\sample.pdf"
strPrinter = "Generic Postscript Printer”

oPDFActiveX.CreatePDFfromCrystalReport strPDF, strRPT, strPrinter

If Err.Number Then

MsgBox Err.Number & " : " & Err.Description, vbExclamation, "Error Message"
MsgBox "Crystal Reports must be installed on this machine.", vbinformation, "M essage"

End If

'‘Open the PDF
If Err.Number Then

MsgBox Err.Number & " : " & Err.Description, vbExclamation, "Error Message"

Else
‘open PDFfile

ShellExecute O, vbNull String, strPDF, vbNullString, vbNullString, 1

End If

kkhkkhkkkkhhkkhkkhhkkhkkhhkhkkhhkhkhhkkhkhkhkkhkhkhkhkhhkhkhhkhkhhkhkkhhkhkhhkhkhhkhkhhkhkhhkhkhkhkkhkhkkhkhhkhkhhkhkhhkhkkhhkkhkkhkkkhkkk kkk,kkxk,kx*x*%

CreatePDFfromExcel() - Method to create an Adobe Acrobat (PDF) file from an Excel worksheet.

Requirements: Excel
Arguments:

StrPDFFile As String

StrExcel Workbook As String
VarExcelWorksheet As Variant
strRange As String

Optiona strPrinter As String

Optional strPassword As String
Optiona strWriteResPassword As String
Optional binUseGrid As Boolean
Optional binLandscape As Boolean
Optional strHeader As String

Optiona IngHeaderAlignment AsLong
Optional strFooter As String

Optiona IngFooterAlignment AsLong
Optional dblTopMargin As Double
Optional dblLeftMargin As Double
Optional dblRightMargin As Double
Optiona dblBottomMargin As Double
Optional dolHeaderMargin As Double
Optional dblFooterMargin As Double
Optional IngFirstPageNumber AsLong

Example:

Dim strPDF As String
Dim strWB As String

PDF fileto create

Excel workbook fileto use

Excel worksheet to use. Can be aname or number

Excel worksheet range to use

Print driver. Default: “ Generic PostScript Printer”

Excel workbook password

Excel workbook write reserve password

Use grid lines. Vaues: True,False

Page orientation. Values: True,False

Page header

Page header alignment. Values: O=left, 1=center, 2=right
Page footer

Page footer alignment. Values: O=left, 1=center, 2=right
Page top margin in inches

Page left margin in inches

Page right margin in inches

Page bottom margin in inches

Page header margin in inches

Page footer margin in inches

Beginning page number



Dim strRange As String
Dim strPrinter As String

On Error Resume Next
Screen.MousePointer = vbHourglass

strPDF = App.Path & "\sample.pdf"

strWB = App.Path & "\sample.xIs"

"Thisis the name of the Adobe PostScript Print Driver
strPrinter = "Generic Postscript Printer”

"There are three ways to specify the worksheet range. Use only one:
strRange = "October" 'Range name

'strRange = "A1:E111" 'Row and column range

'strRange = "Print_Ared" 'Print range

oPDFActiveX.CreatePDFfromExcel strPDF, strWB, 1, strRange, strPrinter, , , , , "Page & P', pdoAlignRight, "&D
&T", pdoAlignCenter, 1#, 0.5, O#, 1#

If Err.Number Then
MsgBox Err.Number & " : " & Err.Description, vbExclamation, "Error Message"
MsgBox "Excel must be installed on this machine.”", vblnformation, "M essage”
End If

Screen.MousePointer = vbDefault

If Err.Number Then

MsgBox Err.Number & " : " & Err.Description, vbExclamation, "Error Message”
Else

‘open PDFfile

ShellExecute 0, vbNull String, strPDF, vbNullString, vbNull String, 1
End If
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CreatePDFfromimageFile() - Method to create an Adobe Acrobat (PDF) file from an image file
(JPG,GIF,BMP,TIF,PNG,PCX ,etc.). This method does not automatically resize the image to fit the page.

Requirements. File PDFOSEND.EXE

Arguments:

strPDFFile As String PDF file to create

strimageFile As String Image fileto use

Optional sngXpos As Single X position

Optional sngY pos As Single Y position

Optional sngWidth As Single Width in pixels

Optional sngHeight As Single Height in pixels

Optional strPrinter As String Print driver. Default: “ Generic PostScript Printer”
Optional strSaveWindowCaption As String Window caption. Default: “print to file”

Example:



Dim strPDF As String
Dim strJPG As String
Dim strPrinter As String

On Error Resume Next
Screen.MousePointer = vbHourglass

strPDF = App.Path & "\file.pdf"
strJPG = App.Path & "\imagel.jpg"
strPrinter = "Generic Postscript Printer”

oPDFActiveX.CreatePDFfromlmageFile strPDF, strJPG, 100, 1000, O, O, strPrinter
'oPDFActiveX.CreatePDFf romlmageFile strPDF, strJPG, 100, 1000, 5000, 4000, strPrinter

If Err.Number Then
MsgBox Err.Number & " : " & Err.Description, vbExclamation, "Error Message"
End If

Screen.MousePointer = vbDefault

If Err.Number = 0 Then

‘'open PDFfile

ShellExecute O, vbNull String, strPDF, vbNullString, vbNullString, 1
End If

hhhhhhkhkhkhkhhkhhdhhhhhhhddddhhhhhhhddddhhdhhhhdhddddhhhhhhhddddhhdhhhhdhdddhhhddhhhdddddhhdddxdx%x

CreatePDFfromlmageFile2() - Method to create an Adobe Acrobat (PDF) file from an image file
(JPG,GIF,BMP, TIF,PNG,PCX ,etc.). This method automatically resizes the image to fit the page using Window’s
file RNDLL32.EXE.

Requirements. File PDFOSEND.EXE

Arguments:

strPDFFile As String PDF file to create

strimageFile As String Image fileto use

Optional strPrinter As String Print driver. Default: “ Generic PostScript Printer”
Optional strSaveWindowCaption As String Window caption. Default: “print to file”
Example:

Dim strPDF As String
Dim strJPG As String
Dim strPrinter As String
On Error Resume Next

Screen.MousePointer = vbHourglass

strPDF = App.Path & "\file.pdf"



strJPG = App.Path & "\imagel.jpg"
strPrinter = "Generic Postscript Printer”

oPDFActiveX.CreatePDFfromlmageFile2 strPDF, strJPG, strPrinter
If Err.Number Then
MsgBox Err.Number & " : " & Err.Description, vbExclamation, "Error Message"
End If
Screen.MousePointer = vbDefault
If Err.Number = 0 Then
‘open PDFfile

ShellExecute O, vbNull String, strPDF, vbNullString, vbNullString, 1
End If

AR R R R R R R R R A A A A A A A A A A A A A A A A R A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A AR AR AR AR AR AR AR Ak hkk%k
CreatePDFfromMultiAccess() - Method to create an Adobe Acrobat (PDF) file from multiple Access reports.
Requirements: Access and file PDFOSEND.EXE

Note: Reports must exist in the same database

Arguments:

strPDFFile As String PDF fileto create

strDatabase As String Database to use

varReportNames As Variant Array of report names

Optional strPrinter As String Print driver. Default: “ Generic PostScript Printer”
Optional strPassword As String Password to use

Optional strSaveWindowCaption As String Window caption. Default: “print to file”
Example:

Dim strPDF As String

Dim strMDB As String

Dim strRPT As String

Dim arr(1) As String

On Error Resume Next

Screen.MousePointer = vbHourglass

strPDF = App.Path & "\Report.pdf"

strMDB = App.Path & "\Author.mdb"

arr(0) = "Authors"

arr(1l) ="Sales"

‘Note: Y ou may need to modify thisfile path

'strMDB = "C:\Program Files\Microsoft Visual Studio\VB98\NWIND.MDB"
‘arr(0) = "invoice"

‘arr(1) = "catalog”

'If you are using a non-English version of Windows/Acrobat

'you can modify parameter strSaveWindowCaption
oPDFActiveX.CreatePDFfromMulti AccessReport strPDF, strMDB, arr
Screen.MousePointer = vbDefault



If Err.Number Then

MsgBox Err.Number & " : " & Err.Description, vbExclamation, "Error Message"
MsgBox "Access must be installed on this machine.”, vblnformation, "M essage”

Else

ShellExecute O, vbNull String, strPDF, vbNullString, vbNullString, 1

End If
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CreatePDFfromMultiAutoCAD() - Method to create an Adobe Acrobat (PDF) file from multiple AutoCAD layouts.

Requirements: AutoCAD and file PDFOSEND.EXE

Note: Layouts must exist in the same drawing file.

Arguments:

strPDFFile As String
strDWGFile As String
varLayouts As Variant
Optional strPrinter As String

Optional strSaveWindowCaption As String

Example:

Dim arr(1) As String
arr(0) = “Layoutl”
arr(1) = “Layout2”

PDF file to create

Drawing fileto use

array of layout names/numbers

Print driver. Default: “ Generic PostScript Printer”
Window caption. Default: “print to file”

oPDFActiveX.CreatePDFfromMultiAutoCAD *“c:\file.pdf”, “c:\drawing.dwg”, arr
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CreatePDFfromMultiExcel() - Method to create an Adobe Acrobat (PDF) file from multiple Excel worksheets.

Requirements. Excel

Note: Worksheets must exist in the same wor kbook.

Arguments:

strPDFFile As String

strExcel Workbook As String
varExcelWorksheets As Variant
varRanges As Variant

Optiona strPrinter As String

Optional strPassword As String
Optional strWriteResPassword As String
Optional binUseGrid As Boolean
Optional varLandscape As Variant
Optional strHeader As String

Optiona IngHeaderAlignment AsLong
Optional strFooter As String

Optional IngFooterAlignment AsLong

PDF fileto create

Excel workbook file to use

Excel worksheetsto use (array). Can be a name or number
Excel worksheet rangesto use (array)

Print driver. Default: “ Generic PostScript Printer”

Excel workbook password

Excel workbook write reserve password

Use grid lines. Vaues: True,False

Page orientation (array). Values. True,False

Page header

Page header alignment. Values: O=left, 1=center, 2=right
Page footer

Page footer alignment. Values: O=left, 1=center, 2=right



Optional dblTopMargin As Double
Optional dblLeftMargin As Double
Optional dblRightMargin As Double
Optional dblBottomMargin As Double
Optional dolHeaderMargin As Double
Optional dblFooterMargin As Double
Optional varFirstPageNumber As Variant

Example:

Dim strPDF As String

Dim strWWB As String

Dim varWorksheets(2) As Integer
Dim varRanges(2) As String

Dim varLandscape(2) As Boolean
Dim varFirstPageNumber(2) AsLong
Dim strPassword As String

Dim strPrinter As String

On Error Resume Next
Screen.MousePointer = vbHourglass

strPDF = App.Path & "\sample.pdf"
strWB = App.Path & "\sample.xIs"
varWorksheets(0) = 1
varWorksheets(1) = 2
varWorksheets(2) = 3

strPrinter = "Generic Postscript Printer”

Page top margin in inches

Page left margin in inches

Page right margin in inches
Page bottom margin in inches
Page header margin in inches
Page footer margin in inches
Beginning page numbers (array)

"There are three ways to specify worksheet ranges

'1) Range names
varRanges(0) = "October"
'varRanges(1) = "November"
'varRanges(2) = "December"
'2) Row and Column ranges
'varRanges(0) ="A1:E111"
varRanges(1) = "A1:E131"
'varRanges(2) = "A1.E46"

'3) Print ranges
'varRanges(0) = "Print_Area"
'varRanges(1) = "Print_Area’
varRanges(2) = "Print_Area’

varLandscape(0) = False
varLandscape(l) = True
varLandscape(2) = False
varFirstPageNumber(0) = 1
varFirstPageNumber(1) = 4
varFirstPageNumber(2) = 8



oPDFActiveX.CreatePDFfromMultiExcel strPDF, strWB, varWorksheets, varRanges, strPrinter, , , , varLandscape,
"Page & P", pdoAlignRight, "&D & T", pdoAlignCenter, 1#, 0.5, O#, 1#, , , varFirstPageNumber

If Err.Number Then
MsgBox Err.Number & " : " & Err.Description, vbExclamation, "Error Message"
MsgBox "Excel must be installed on this machine.", vblnformation, "Message"
End If

Screen.MousePointer = vbDefault

If Err.Number Then

MsgBox Err.Number & " : " & Err.Description, vbExclamation, "Error Message"
Else

‘'open PDFfile

ShellExecute 0, vbNull String, strPDF, vbNullString, vbNullString, 1
End If
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CreatePDFfromMultiPDF() - Method to create a PDF file from multiple PDF files.

Arguments:

strPDFFile As String PDF file to create

varPDFFiles As Variant PDF filesto use (stored in one dimensional array)
Example:

Dim strPDF As String
Dim strPDFS(1) As String

On Error Resume Next
Screen.MousePointer = vbHourglass

'PDF file to create
strPDF = AppPath & "\multiple.pdf"

'PDF files to create
strPDFS(0) = AppPath & "\filel.pdf"
strPDFS(1) = AppPath & "\file2.pdf"

oPDFmaker.CreatePDFfromWord strPDFS(0), AppPath & "\debug.doc”, strPrinter
oPDFmaker.CreatePDFfromExcel strPDFS(1), AppPath & "\samplexIs®, 1, "October", strPrinter, , , , , "Page & P,
pdoAlignRight, "&D & T", pdoAlignCenter, 1#, 0.5, O#, 1#

'‘Combine multiple PDF files to create asingle PDF file
oPDFmaker.CreatePDFfromMultiPDF strPDF, strPDFS

Screen.MousePointer = vbDefault

If Err.Number Then
MsgBox Err.Number & " : " & Err.Description, vbExclamation, "Error Message”



Else

‘'open PDF file

ShellExecute 0, vbNull String, strPDF, vbNullString, vbNullString, 1
End If

kkhkkkkhkkkhhkkhkkhhkhkkhhkhkhhkhkkhhkhkhhkhkkhhhkhkhhkhkhhkhkhhkhkhhkhkhhkhhhkhhhkhkkhhkhkhhkkhkhkkhkhhkkhkhhkhkhhkhkkhhkhkkhhkhkkhkhkhkkhkhkkhkkk**x

CreatePDFfromMultiPDFinDir() - Method to create a PDF file from multiple PDF files.

Arguments:

strPDFFile As String PDF file to create

strDirectory As String Directory to scan

Optional strFiles As String = "* .pdf" PDF filesto use (Can use * and ? wildcard characters)
Optional IngSortType AsLong Sort type. Values: 0 = None, 1 = Name, 2 = Size, 3 = Date
Optional IngSortOrder As Long Sort order. Values: 0 = Ascending, 1 = Descending
Example:

Dim strPDF As String

On Error Resume Next
Screen.MousePointer = vbHourglass
strPDF = AppPath & "\multiple.padf"

Kill strPDF
Err.Clear 'clear "file not found" error

'Create asingle PDF from all PDFsfilesin directory matching *.pdf
oPDFmaker.CreatePDFfromMultiPDFinDir strPDF, AppPath, "*.pdf", pdoSortByName, pdoSortOrderAscending

Screen.MousePointer = vbDefault

If Err.Number Then

MsgBox Err.Number & " : " & Err.Description, vbExclamation, "Error Message”
Else

‘'open PDFfile

ShellExecute 0, vbNull String, strPDF, vbNullString, vbNull String, 1
End If
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CreatePDFfromMultiPS() - Method to create an Adobe Acrobat (PDF) file from multiple PostScript (PS) files.

Arguments:
strPDFFile As String PDF fileto create
varPSFiles As Variant Postscript files to use (stored in one dimensional array)

Example:



Dim strPDF As String

Dim strPS(1) As String

Dim strPrinter As String

Dim strWWB As String

Dim strRange As String

Dim strDoc As String

Dim strPagesToPrint As String

On Error Resume Next
Screen.MousePointer = vbHourglass

'PDF fileto create
strPDF = App.Path & "\multiple.pdf"

'PostScript files to create
strPS(0) = App.Path & "\sample.ps"
strPS(1) = App.Path & "\debug.ps"

'Printer driver name
strPrinter = "Generic Postscript Printer”

'Excel workbook

strWB = App.Path & "\sample.xIs"

"There are three ways to specify the worksheet range. Use only one:
strRange = "October" 'Range name

'strRange = "A1:E111" 'Row and column range

'strRange = "Print_Ared" 'Print range

"‘Word document

strDoc = App.Path & "\debug.doc”
'Pagesto use

strPagesToPrint ="1, 3, 6-8, 10"

'Create PostScript file from Excel worksheet
oPDFActiveX.CreatePSfromExcel strPS(0), strwB, 1, strRange, , , , , , "Page & P", pdoAlignRight, "&D & T",
pdoAlignCenter, 1#, 0.5, O#, 1#

'Create PostScript file from Word document
oPDFActiveX.CreatePSfromWord strPS(1), strDoc, , , , strPagesToPrint

'‘Combine PostScript files and create a PDF file
oPDFAcctiveX.CreatePDFfromMulti PS strPDF, strPS

Screen.MousePointer = vbDefault

If Err.Number Then

MsgBox Err.Number & " : " & Err.Description, vbExclamation, "Error Message"
Else

‘open PDFfile

ShellExecute O, vbNullString, strPDF, vbNullString, vbNull String, 1
End If



kkhkkhkkkkhhkkkhhkkhkkhhkhkkhhkhkhhkkhhkhkhkhhkhkhhkhkhhkhkhhkhkhhkhkhhkhkhhkhkhhkhkhhhkhkhkhkkhkhkkhkhkkhkhkkhkhhkhkkhhkkhkkhhkkhkkk kkk,kkk,kx*x*%

CreatePDFfromPowerPoint() - Method to create an Adobe Acrobat (PDF) file from a PowerPoint file.

Requirements: Power Point
Arguments:

strPDFFile As String

strPPDocument As String

Optional strPrinter As String

Optional IngStartSlide AsLong =-1

Optional IngendSlide AsLong =-1

Optional binHorizontal Orientation As Boolean
Optional binBlackAndWhite As Boolean

Example:

Dim strPDF As String

Dim strDoc As String

Dim strPrinter As String

On Error Resume Next
Screen.MousePointer = vbHourglass
strPDF = App.Path & "\file.pdf"

strDoc = App.Path & "\file.ppt"
strPrinter = "Generic Postscript Printer”

PDF fileto create

PowerPoint file to use

Print driver. Default: “ Generic PostScript Printer”
PowerPoint start slide to use

PowerPoint end slide to use

PowerPoint dlide orientation. Values: True,False
Black and white?

oPDFActiveX.CreatePDFfromPowerPoint strPDF, strDoc, strPrinter

If Err.Number Then

MsgBox Err.Number & " : " & Err.Description, vbExclamation, "Error Message"
MsgBox "Powerpoint must be installed on this machine.”, vbinformation, "M essage"

End If

Screen.MousePointer = vbDefault

If Err.Number Then

MsgBox Err.Number & " : " & Err.Description, vbExclamation, "Error Message”

Else
‘'open PDFfile

ShellExecute 0, vbNull String, strPDF, vbNullString, vbNullString, 1

End If
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CreatePDFfromPS() - Method to create an Adobe Acrobat (PDF) file from a PostScript (PS) file.

Arguments:

strPDFFile As String PDF fileto create



strPSFile As String Postscript file to use
Example:

Dim strPS As String

Dim strPDF As String

Dim strWWB As String

Dim strRange As String
Dim strPassword As String

On Error Resume Next
Screen.MousePointer = vbHourglass

strPS = App.Path & "\sample.ps’
strPDF = App.Path & "\sample.pdf"
strWB = App.Path & "\sample.xIs"

"There are three ways to specify the worksheet range. Use only one:
strRange = "October" 'Range name

'strRange = "A1:E111" 'Row and column range

'strRange = "Print_Ared" 'Print range

‘create a PostScript file from Excel workbook worksheet range
oPDFActiveX.CreatePSfromExcel strPS, strWB, 1, strRange, , , , , , "Page &P", pdoAlignRight, "&D & T",
pdoAlignCenter, 1#, 0.5, O#, 1#

If Err.Number Then
MsgBox Err.Number & " : " & Err.Description, vbExclamation, "Error Message”
MsgBox "Excel must be installed on this machine.", vblnformation, "M essage”
End If

‘create a PDF file from a PostScript file
oPDFA ctiveX.CreatePDFfromPS strPDF, strPS

Screen.MousePointer = vbDefault
If Err.Number Then

MsgBox Err.Number & " : " & Err.Description, vbExclamation, "Error Message”
Else

‘open PDFfile

ShellExecute 0, vbNull String, strPDF, vbNullString, vbNull String, 1
End If
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CreatePDFfromTextFile() - Method to create an Adobe Acrobat (PDF) file from atext file.
Requirements: Word
Arguments:

strPDFFile As String PDF fileto create



strTextFile As String

Optional strPrinter As String

Optional binLandscape As Boolean

Optional strFont As String

Optional binFontBold As Boolean

Optional intFontSize As Integer = 8

Optional IngFontColor AsLong

Optional binFontltalic As Boolean

Optional binFontUnderline As Boolean
Optional binPageNumberInFooter As Boolean
Optional blnPageNumberlnHeader As Boolean
Optional IngPageNumberAlignment As Long
Optional sngTopMargin As Single

Optional sngLeftMargin As Single

Optional sngRightMargin As Single

Optional sngBottomMargin As Single
Optional binFirstPage As Boolean = True

Example:

Dim strPDF As String

Dim strTXT As String

Dim strPrinter As String

On Error Resume Next
Screen.MousePointer = vbHourglass
strPDF = App.Path & "\file.pdf"
strTXT = App.Path & "\file.txt"
strPrinter = "Generic Postscript Printer”

'‘CreatePDFfromTextFile requires Microsoft Word

Text fileto use

Print driver. Default: “ Generic PostScript Printer”
Page orientation. Values: True,False

Font name. Default is* Courier”

Font bold. Values. True,False

Font size

Font color

Font italic. Values: True,False

Font underline. Values: True,False

Place page number in footer. Values: True,False
Place page number in header. Values: True,False

Page number alignment. Values: O=left, 1=center, 2=right

Page top margin
Page left margin
Page right margin
Page bottom margin
Add page number to first page? Values: True,False

‘use methods CreatePDFfromTextFile2 or CreatePDFfromTextFile3

'if you don't have Microsoft Word

oPDFActiveX.CreatePDFfromTextFile strPDF, strTXT, strPrinter, False, "arial”, False, 12, RGB(0, 0, 255), False,
False, False, True, pdoAlignRight, 20.5, 20.5, , 20.5

If Err.Number Then

MsgBox Err.Number & " : " & Err.Description, vbExclamation, "Error Message"
MsgBox "Word must be installed on this machine.”", vbinformation, "M essage"

End If

Screen.MousePointer = vbDefault

If Err.Number Then

MsgBox Err.Number & " : " & Err.Description, vbExclamation, "Error Message”

Else
‘'open PDFfile

ShellExecute 0, vbNull String, strPDF, vbNullString, vbNull String, 1

End If
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CreatePDFfromTextFile2() - Method to create an Adobe Acrobat (PDF) file from atext file.

Requirements: Notepad and file PDFOSEND.EXE

Arguments:

strPDFFile As String PDF file to create

strTextFile As String Text fileto use

Optional strPrinter As String Print driver. Default: “ Generic PostScript Printer”
Optional strSaveWindowCaption As String Window caption. Default: “print to file”
Example:

Dim strPDF As String
Dim strTXT As String
Dim strPrinter As String

On Error Resume Next
Screen.MousePointer = vbHourglass

strPDF = App.Path & "\file.pdf"
strTXT = App.Path & "\file.txt"
strPrinter = "Generic Postscript Printer”

'CreatePDFfromTextFile requires Microsoft Word

‘use methods CreatePDFfromTextFile2 or CreatePDFfromTextFile3

'if you don't have Microsoft Word

oPDFActiveX.CreatePDFfromTextFile2 strPDF, strTXT

If Err.Number Then
MsgBox Err.Number & " : " & Err.Description, vbExclamation, "Error Message"
MsgBox "Notepad must be installed on this machine.”, vbinformation, "Message"

End If

Screen.MousePointer = vbDefault
If Err.Number Then

MsgBox Err.Number & " : " & Err.Description, vbExclamation, "Error Message”
Else

‘open PDFfile

ShellExecute 0, vbNull String, strPDF, vbNullString, vbNull String, 1
End If
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CreatePDFfromTextFile3() - Method to create an Adobe Acrobat (PDF) file from atext file.

Requirements: File PDFOSEND.EXE

Arguments:

strPDFFile As String PDF fileto create



strTextfile As String Text fileto use

Optional intRightMargin As Integer Right margin

Optional strPrinter As String Print driver. Default: “ Generic PostScript Printer”
Optional strSaveWindowCaption As String Window caption. Default: “print to file”
Example:

Dim strPDF As String
DimstrTXT As String
Dim strPrinter As String

On Error Resume Next
Screen.MousePointer = vbHourglass

strPDF = App.Path & "\file.pdf"
strTXT = App.Path & "\file.txt"
strPrinter = "Generic Postscript Printer”

'‘CreatePDFfromTextFile requires Microsoft Word

‘use methods CreatePDFfromTextFile2 or CreatePDFfromTextFile3

'if you don't have Microsoft Word

oPDFActiveX.CreatePDFfromTextFile3 strPDF, strTXT

If Err.Number Then
MsgBox Err.Number & " : " & Err.Description, vbExclamation, "Error Message”
MsgBox "Word must be installed on this machine.", vblnformation, "M essage"

End If

Screen.MousePointer = vbDefault

If Err.Number Then

MsgBox Err.Number & " : " & Err.Description, vbExclamation, "Error Message"
Else

‘open PDFfile

ShellExecute 0, vbNullString, strPDF, vbNullString, vbNull String, 1
End If
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CreatePDFromVisio() - Method to create an Adobe Acrobat (PDF) file from aVisiofile.

Requirements: Visio and file PDFOSEND.EXE

Arguments:

strPDFFile As String PDF file to create

strVisioFile As String Visiofileto use

Optional strPrinter As String Print driver. Default: “ Generic PostScript Printer”
Optiona strSaveWindowCaption As String Window caption. Default: “print to file”
Example:

Dim strPDF As String



Dim strvVSD As String
Dim strPrinter As String

On Error Resume Next
Screen.MousePointer = vbHourglass
strPDF = App.Path & "\bflowcht.pdf"

strVSD = App.Path & "\bflowcht.vsd"
strPrinter = "Generic Postscript Printer”

OPDFActiveX.CreatePDFfromVisio strPDF, strV SD, strPrinter

Screen.MousePointer = vbDefault

If Err.Number Then

MsgBox Err.Number & " : " & Err.Description, vbExclamation, "Error Message"
MsgBox "Visio must be installed on this machine.", vbinformation, "Message"

Else
‘'open PDF file

ShellExecute O, vbNull String, strPDF, vbNullString, vbNullString, 1

End If
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CreatePDFfromWord() - Method to create an Adobe Acrobat (PDF) file from a Word document.

Requirements: Word
Arguments:

strPDFFile As String

strWordDocument As String

Optional strPrinter As String

Optiona strPassword As String

Optional strWritePassword As String

Optional strPages As String

Optional binLandscape As Boolean

Optional binPageNumberInFooter As Boolean
Optional blnPageNumberlnHeader As Boolean
Optional IngPageNumberAlignment As Long
Optional binFirstPage As Boolean

Example:

Dim strPDF As String
Dim strDoc As String
Dim strPrinter As String

On Error Resume Next

Screen.MousePointer = vbHourglass

PDF fileto create

Word document to use

Print driver. Default: “ Generic PostScript Printer”
Word document password

Word document write password

Word document pages to use

Page orientation. Values: True,False

Place page number in footer. Values: True,False
Place page number in header. Values: True,False
Page number alignment. Values. O=left, 1=center, 2=right
Add page number to first page? Values: True,False



strPDF = App.Path & "\debug.pdf"
strDoc = App.Path & "\debug.doc"
strPrinter = "Generic Postscript Printer”

oPDFActiveX.CreatePDFfromWord strPDF, strDoc, strPrinter

If Err.Number Then
MsgBox Err.Number & " : " & Err.Description, vbExclamation, "Error Message"
MsgBox "Word must be installed on this machine.", vblnformation, "M essage”
End If

Screen.MousePointer = vbDefault

If Err.Number Then

MsgBox Err.Number & " : " & Err.Description, vbExclamation, "Error Message"
Else

‘open PDFfile

ShellExecute O, vbNull String, strPDF, vbNullString, vbNullString, 1
End If
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CreatePSfromA ccessReport() - Method to create a PostScript (PS) file from an Access Report.

Requirements: Access and file PDFOSEND.EXE

Arguments:

strPSFile As String Postscript file to create

strDatabase As String Access database to use

strReportNameAs String Access report to use

Optional strPrinter As String Print driver. Default: “ Generic PostScript Printer”
Optional strPassword As String Access database password

Optional strFilter As String Access report filter

Optiona strWhereCondition As String Access report where condition

Optional strSaveWindowCaption As String Window caption. Default: “print to file”
Example:

Dim strPS As String
Dim strMDB As String
Dim strRPT As String
Dim strPrinter As String
On Error Resume Next

Screen.MousePointer = vbHourglass
strPS = App.Path & "\Report.ps"
strMDB = App.Path & "\Author.mdb"
strPrinter = "Generic Postscript Printer”

‘Note: Y ou may need to modify thisfile path
'strMDB = "C:\Program Files\Microsoft Visual Studio\VB98\NWIND.MDB"
'If you are using a non-English version of Windows



'you can modify parameter strSaveWindowCaption

'Use code below to create a PDF from a single report
StrRPT = "authors'
oPDFActiveX.CreatePSfromA ccessReport strPS, strMDB, strRPT, strPrinter
Screen.MousePointer = vbDefault
If Err.Number Then
MsgBox Err.Number & " : " & Err.Description, vbExclamation, "Error Message"
MsgBox "Access must be installed on this machine.”, vblnformation, "M essage”
End If
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CreatePSfromAutoCAD() - Method to create a PostScript (PS) file from an AutoCAD drawing.

Requirements: Access and file PDFOSEND.EXE

Arguments:

strPSFile As String Postscript file to create

strDWGFile As String Drawing fileto use

Optional varLayout As Variant Layout to use

Optional strPrinter As String Print driver. Default: “ Generic PostScript Printer”
Optional strSaveWindowCaption As String Window caption. Default: “print to file”
Example:

Dim strPS As String

Dim strDWG As String
Dimi AsInteger

Dim strPassword As String
Dim strPrinter As String

On Error Resume Next
strPS = App.Path & "\HellowWorld.ps"
strDWG = App.Path & "\HelloWorld.dwg" 'can also use DXF files
strPrinter = "Generic Postscript Printer”
oPDFActiveX.CreatePSfromAutoCAD strPS, strDWG, "layoutl”, strPrinter
If Err.Number Then
MsgBox Err.Number & " : " & Err.Description, vbExclamation, "Error Message”

MsgBox "AutoCAD must be installed on this machine.", vblnformation, "M essage”
End If
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CreatePSfromCrystal Report() - Method to create a PostScript (PS) file from a Crystal Report.
Requirements: Crystal Reports and file PDFOSEND.EXE

Arguments:



strPSFile As String

strCrystalReport As String

Optional strPrinter As String

Optional strSaveWindowCaption As String

Example:

Dim strRPT As String
Dim strPS As String
Dimi AsLong

Dim strPrinter As String

On Error Resume Next
strRPT = App.Path & "\sample.rpt"

strPS = App.Path & "\sample.ps’
strPrinter = "Generic Postscript Printer”

Postscript file to create
Report to use

Print driver. Default: “ Generic PostScript Printer”

Window caption. Default: “print to file”

oPDFActiveX.CreatePSfromCrystalReport strPS, strRPT, strPrinter

If Err.Number Then

MsgBox Err.Number & " : " & Err.Description, vbExclamation, "Error Message"
MsgBox "Crystal Reports must be installed on this machine.", vbinformation, "M essage"

End If

If Err.Number Then

MsgBox Err.Number & " : " & Err.Description, vbExclamation, "Error Message"

End If
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CreatePSfromExcel () - Method to create a PostScript (PS) file from an Excel worksheet.

Requirements; Excel
Arguments:

strPSFile As String

strExcel Workbook As String
VarExcelWorksheet As Variant
strRange As String

Optiona strPrinter As String

Optional strPassword As String
Optiona strWriteResPassword As String
Optional binUseGrid As Boolean
Optional binLandscape As Boolean
Optional strHeader As String

Optiona IngHeaderAlignment AsLong
Optional strFooter As String

Optional IngFooterAlignment AsLong
Optional dblTopMargin As Double
Optional dblLeftMargin As Double

Postscript file to create

Excel workbook file to use

Excel worksheet to use. Can be a name or number
Excel worksheet range to use

Print driver. Default: “ Generic PostScript Printer”
Excel workbook password

Excel workbook write reserve password

Use grid lines. Vaues: True,False

Page orientation. Values: True,False

Page header

Page header alignment. Values: O=left, 1=center, 2=right

Page footer

Page footer alignment. Values: O=left, 1=center, 2=right

Page top margin in inches
Page |left margin in inches



Optional dblRightMargin As Double Page right margin in inches
Optional dblBottomMargin As Double Page bottom margin in inches
Optional dolHeaderMargin As Double Page header margin in inches
Optional dblFooterMargin As Double Page footer margin in inches
Optional IngFirstPageNumber AsLong =1 Beginning page number

Example:

Dim strPS As String
Dim strWWB As String
Dim strRange As String

On Error Resume Next
Screen.MousePointer = vbHourglass

strPS = App.Path & "\sample.ps’
strWB = App.Path & "\sample.xIs"

"There are three ways to specify the worksheet range. Use only one:
strRange = "October" 'Range name

'strRange = "A1:E111" 'Row and column range

'strRange = "Print_Area" 'Print range

oPDFActiveX.CreatePSfromExcel strPS, strWB, 1, strRange, , , , , , "Page &P", pdoAlignRight, "&D & T",
pdoAlignCenter, 1#, 0.5, O#, 1#

Screen.MousePointer = vbDefault

If Err.Number Then
MsgBox Err.Number & " : " & Err.Description, vbExclamation, "Error Message”
MsgBox "Excel must be installed on this machine.", vblnformation, "M essage”
Else
MsgBox "PostScript file created.”, vbinformation, "M essage"
End If
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CreatePSfromlmageFile() - Method to create a PostScript (PS) file from an imagefile.

Requirements. File PDFOSEND.EXE

Arguments:

strPSFile As String Postscript file to create

strimagefile As String Imagefileto use

Optional sngXpos As Single X position

Optional sngY pos As Single Y position

Optional sngWidth As Single Width in pixels

Optional sngHeight As Single Height in pixels

Optional strPrinter As String Print driver. Default: “ Generic PostScript Printer”

Optional strSaveWindowCaption As String Window caption. Default: “print to file”



Example:
Dim strPS As String
Dim strJPG As String
Dim strPrinter As String
On Error Resume Next
Screen.MousePointer = vbHourglass
strPS = App.Path & "\file.ps’
strJPG = App.Path & "\imagel.jpg"
strPrinter = "Generic Postscript Printer”
oPDFAcctiveX.CreatePSfromlmageFile strPS, strJPG, 100, 1000, 0, O, strPrinter
If Err.Number Then
MsgBox Err.Number & " : " & Err.Description, vbExclamation, "Error Message"
End If
Screen.MousePointer = vbDefault
If Err.Number Then

MsgBox Err.Number & " : " & Err.Description, vbExclamation, "Error Message"
End If
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CreatePSfromPowerPoint() - Method to create a PostScript (PS) file from a PowerPoint file.

Requirements: Power Point

Arguments:

strPSFile As String Postscript file to create

strPPDocument As String PowerPoint file to use

Optional strPrinter As String Print driver. Default: “ Generic PostScript Printer”
Optional IngStartSlide AsLong = -1 PowerPoint start slide to use

Optional IngendSlide AsLong =-1 PowerPoint end slide to use

Optional binHorizontal Orientation As Boolean PowerPoint slide orientation. Values: True,False
Optional binBlackAndWhite As Boolean Black and white?

Example:

Dim strPS As String
Dim strDoc As String

On Error Resume Next
Screen.MousePointer = vbHourglass

strPS = App.Path & "\file.ps’
strDoc = App.Path & "\file.ppt"



OPDFA ctiveX .CreatePSfromPowerPoint strPS, strDoc

Screen.MousePointer = vbDefault

If Err.Number Then

MsgBox Err.Number & " : " & Err.Description, vbExclamation, "Error Message"
MsgBox "Powerpoint must be installed on this machine.”, vbinformation, "M essage"

Else

MsgBox "PostScript file created.”, vblnformation, "Message"

End If
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CreatePSfromTextFile() - Method to create a PostScript (PS) file from atext file.

Requirements: Word
Arguments:

strPSFile As String

strTextFile As String

Optional strPrinter As String

Optional binLandscape As Boolean

Optional strFont As String

Optional binFontBold As Boolean

Optional intFontSize As Integer = 8

Optional IngFontColor AsLong

Optional binFontltalic As Boolean

Optional binFontUnderline As Boolean
Optional blnPageNumberInFooter As Boolean
Optional blnPageNumberlnHeader As Boolean
Optional IngPageNumberAlignment As Long
Optional sngTopMargin As Single

Optional sngLeftMargin As Single

Optional sngRightMargin As Single

Optiona sngBottomMargin As Single
Optional binFirstPage As Boolean = True

Example:

Dim strPS As String
Dim strTXT As String

On Error Resume Next
Screen.MousePointer = vbHourglass

strPS = App.Path & "\file.ps"
strTXT = App.Path & "\file.txt"

Postscript file to create

Text fileto use

Print driver. Default: “ Generic PostScript Printer”
Page orientation. Values: True,False

Font name. Default is“Courier”

Font bold. Values: True,False

Font size

Font color

Font italic. Values. True,False

Font underline. Values: True,False

Place page number in footer. Values: True,False
Place page number in header. Values: True,False
Page number alignment. Values. O=left, 1=center, 2=right
Page top margin

Page left margin

Page right margin

Page bottom margin

Add page number to first page? Values: True,False

oPDFActiveX.CreatePSfromTextFile strPS, strTXT, , False, "aria", False, 12, RGB(0, 0, 255), False, False, False,

True, pdoAlignRight, 20.5, 20.5, , 20.5



Screen.MousePointer = vbDefault

If Err.Number Then
MsgBox Err.Number & " : " & Err.Description, vbExclamation, "Error Message"
MsgBox "Word must be installed on this machine.", vblnformation, "Message"
Else
MsgBox "PostScript file created.”, vblnformation, "Message"
End If
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CreatePSfromTextFile2() - Method to create a PostScript (PS) file from atext file.

Requirements: Notepad and PDFOSEND.EXE

Arguments:

strPSFile As String Postscript file to create

strTextFile As String Text fileto use

Optional strPrinter As String Print driver. Default: “ Generic PostScript Printer”
Optional strSaveWindowCaption As String Window caption. Default: “print to file”
Example:

Dim strPS As String
Dim strTXT As String

On Error Resume Next
Screen.MousePointer = vbHourglass

strPS = App.Path & "\file.ps"
strTXT = App.Path & "\file.txt"

oPDFActiveX.CreatePSfromTextFile2 strPS, strTXT
Screen.MousePointer = vbDefault

If Err.Number Then
MsgBox Err.Number & " : " & Err.Description, vbExclamation, "Error Message"
MsgBox "Notepad must be installed on this machine.”, vbinformation, "Message"
Else
MsgBox "PostScript file created.”, vblnformation, "M essage"
End If
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CreatePSfromTextFile3() - Method to create a PostScript (PS) file from atext file.
Requirements. File PDFOSEND.EXE

Arguments:



strPSFile As String Postscript file to create

strTextFile As String Text fileto use

Optional intRightMargin As Integer Right margin.

Optional strPrinter As String Print driver. Default: “ Generic PostScript Printer”
Optional strSaveWindowCaption As String Window caption. Default: “print to file”
Example:

Dim strPS As String
Dim strTXT As String

On Error Resume Next
Screen.MousePointer = vbHourglass

strPS = App.Path & "\file.ps’
strTXT = App.Path & "\file.txt"

oPDFActiveX.CreatePSfromTextFile3 strPS, strTXT
Screen.MousePointer = vbDefault

If Err.Number Then

MsgBox Err.Number & " : " & Err.Description, vbExclamation, "Error Message"
Else

MsgBox "PostScript file created.”, vbinformation, "M essage"
End If
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CreatePSfromVisio() - Method to create a PostScript (PS) file from a Visio document.

Requirements. File PDFOSEND.EXE

Arguments:

strPSFile As String Postscript file to create

strVisioFile As String Visio document to use

Optional strPrinter As String Print driver. Default: “ Generic PostScript Printer”
Optiona strSaveWindowCaption As String Window caption. Default: “print to file”
Example:

Dim strPS As String
Dim strVSD As String
Dim strPrinter As String

On Error Resume Next
Screen.MousePointer = vbHourglass
strPS = App.Path & "\bflowcht.ps®

strVSD = App.Path & "\bflowcht.vsd"
strPrinter = "Generic Postscript Printer”



OPDFActiveX .CreatePSfromVisio strPS, strVSD, strPrinter

Screen.MousePointer = vbDefault

If Err.Number Then

MsgBox Err.Number & " : " & Err.Description, vbExclamation, "Error Message"
MsgBox "Visio must be installed on this machine.", vbinformation, "Message"

End If
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CreatePSfromWord() - Method to create a PostScript (PS) file from a Word document.

Requirements: Word
Arguments:

strPSFile As String

strWordDocument As String

Optional strPrinter As String

Optional strPassword As String

Optional strWritePassword As String

Optional strPages As String

Optional binLandscape As Boolean

Optional binPageNumberInFooter As Boolean
Optional blnPageNumberinHeader As Boolean
Optional IngPageNumberAlignment As Long
Optional binFirstPage As Boolean = True

Example:

Dim strPS As String

Dim strDoc As String

Dim strPagesToPrint As String

On Error Resume Next
Screen.MousePointer = vbHourglass
strPS = App.Path & "\debug.ps"

strDoc = App.Path & "\debug.doc”
strPagesToPrint ="1, 3, 6-8, 10"

Postscript file to create

Word document to use

Print driver. Default: “ Generic PostScript Printer”
Word document password

Word document write password

Word document pages to use

Page orientation. Values: True,False

Place page number in footer. Values: True,False
Place page number in header. Values: True,False
Page number alignment. Values. 0=left, 1=center, 2=right
Add page number to first page? Values: True,False

oPDFActiveX.CreatePSfromWord strPS, strDoc, , , , strPagesToPrint

Screen.MousePointer = vbDefault

If Err.Number Then

MsgBox Err.Number & " : " & Err.Description, vbExclamation, "Error Message'

MsgBox "Word must be installed on this machine.", vbinformation, "M essage"

Else

MsgBox "PostScript file created.”, vblnformation, "M essage”



End If
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DownloadFile() - Function to download afile from aremote web server.
Requirements: MSINET.OCX

Note: An internet connection must be established before using this function.
Arguments:

inet As Object

strRemoteHost As String

strRemoteDirectory As String

strLocalFile As String

strRemoteFile As String

Optional strUsername As String
Optional strUserPassword As String

Example:

‘Note: you must modify the remote host settings before this will work
oPDFActiveX.DownloadFile Inet1, "microsoft.com”, "/mydirectory”, "c:\file.txt", "file.txt"
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SetDefPrinter() - Method to set the default system printer.

Arguments:

strPrinter As String Printer to use

Example:

oPDFActiveX.SetDefPrinter “HP DeskJet 890C"
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UploadFile() - Function to copy alocal file to aremote web server.

Requirements: MSINET.OCX

Note: An internet connection must be established before using this function.

Arguments:

inet As Object

strRemoteHost As String

strRemoteDirectory As String

strLocalFile As String

strRemoteFile As String
Optiona strUsername As String



Optional strUserPassword As String
Example:
‘Note: you must modify the remote host settings before this will work

oPDFActiveX.UploadFile Inetl, "www.microsoft.com", "/mydirectory", App.Path & "\table.htm", "table.ntm",
"username”, "password"
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Thereisversion of PDF ActiveX DLL available for web developers which will run on aweb server named
PDF ActiveX DLL for ASP. You can download it from here:

http://www.qgetfilez.com/pdfxasp.zip

Thereisa.NET version of PDF ActiveX DLL named PDF Create .NET for Visual Basic .NET and C#
developers available at:

http://www.qgetfil ez.com/setup.msi

SkySof Software Inc.
http://www.skysof.com
Email: kusluski @bellsouth.net
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